G-Lock EasyMail7
Client-Server Email Marketing Solution for Windows

Startup Guide

To learn more about G-Lock EasyMail7, visit http://easymail7.com
Table of Contents

This document is your startup guide for G-Lock EasyMail7 product. It is designed to provide you with the information you need to install quickly and configure G-Lock EasyMail7.

The following parts are included:

1. G-Lock EasyMail7 Overview
2. 14-Day Trial Version Limitations
3. License Model
4. Installation
5. Activation and First Run
6. Get Started: Settings Configuration
7. Create Message
8. Test Inbox Placement and Spam Score
9. Send Test Message
10. Send Message to the Contact Group
11. Work with EasyMail7 Web Client
12. Useful Articles
13. Support & Contact

To learn more about G-Lock EasyMail7, visit http://easymail7.com
1. G-Lock EasyMail7 Overview

An effective email marketing system should include the following tools:

- Automated email sequences that drip on your contacts over time to build trust and convert your subscribers into active and happy customers.

- An email scheduler for planning your announcements, newsletters, and special occasion emails weeks or even months in advance.

- A simple way for you to create sign-up forms so you can connect your marketing efforts to auto-populate your contact lists (we provide WPNewsman plugin for WordPress for free).

- A professional collection of quality responsive HTML email templates that you can install and use for your newsletters on the fly.

- An automated way of processing bounce and unsubscribe emails to be in compliance with the CAN-SPAM law in various countries.

- Training and support from those who have years of experience in email marketing systems, management and success.

With G-Lock EasyMail7, you have the right email marketing software system to help you maintain and grow your business.

G-Lock EasyMail7 is a PRIVATE and SECURE in-house email marketing solution that eliminates the complexity and expense of operating a third-party email service.

G-Lock EasyMail7 is built on a client-server model. The program consists of two components: EasyMail7 Server and EasyMail7 Client.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
with beautiful, easy to use and understand user interface.

You can install the EasyMail7 Server on a local computer or a Windows Server 2008/2012, Amazon EC2 or Windows Azure Virtual Machine where you can deploy your own customized Windows Server. It runs as a service in the background and does most of the work: send out messages, check for incoming returned messages and update the contact lists.

The EasyMail7 Client can be installed on as many computers as you want. Users log in to the EasyMail7 Server from their computers and manage email lists and campaigns.

Admin can create and manage users and workplaces and assign users to workplaces. Several users can work with one workplace.

To learn more about G-Lock EasyMail7, visit [http://easymail7.com](http://easymail7.com)
simultaneously. Or each user can work with his workplace at the same
time on the EasyMail7 Server.

A workplace includes email server accounts, email templates and
drafts, sent items, contact groups (internal and external lists), and
Bounce Handler settings. Each user has the full control of his
workplace(s) allocated to him by admin.

Admin can set sending limitations for the workplace such as
monthly sending limits and maximum sending slots to control the
server load.

G-Lock EasyMail7 is fully integrated with Amazon SES API as
well as with Amazon SES SMTP, unlike competitors that can work with
Amazon SMTP only. When using the Amazon SES API mode program
automatically controls your Amazon SES account quota limitations to
comply with Amazon SES requirements.

You can have unlimited custom fields for email personalization in
your contact lists, and you have the capability to send to multiple
groups simultaneously.

## 2. 14-Day Trial Version Limitations

The free trial version of G-Lock EasyMail7 is limited to:

- 250 messages per hour;
- 1,000 messages per day;
- 12,000 messages per month;
- 3 credits for Inbox delivery and spam filtering tests.

After the trial period expired, the user must either buy the license
for G-Lock EasyMail7 or discontinue using the program.

To learn more about G-Lock EasyMail7, visit [http://easymail7.com](http://easymail7.com)
3. License Model

G-Lock EasyMail7 license is sold as an annual subscription. This means that when you purchase the license, you receive 12 months of free updates for the EasyMail7 Server and Client from the date of your purchase – be it a minor program update or a major new version. Plus, you receive best in class support from our team.

If you choose not to renew, you can continue using the last version you obtained or are eligible to use. The 12-month time frame is merely for new versions/updates and has no relevance to rights of use (as long as the EULA is not violated).

We have built a business where our focus is on supporting our existing customers. By paying a small maintenance fee every year, you can be assured we will continue improving software and offering the best customer service in the market.

You have unlimited features in ANY paid version. We simply charge a fixed price per user/workplace. We do not try and upsell you to more expensive licenses so you can access specific features. You can be assured that whatever size of business you are and whatever paid license you have, you will always have access to all G-Lock EasyMail7 features.

G-Lock EasyMail7 is backed by a 60-day unconditional money-back guarantee.
4. Installation

**Important!** G-Lock EasyMail7 is NOT compatible with older versions of G-Lock EasyMail. If you have a 6.xx or 5.xx version of G-Lock EasyMail, install G-Lock EasyMail7 to a new directory on your hard drive. Then you can import your contacts into G-Lock EasyMail7.

**To install G-Lock EasyMail7:**

1. Download G-Lock EasyMail7 from [http://easymail7.com](http://easymail7.com)
2. Extract the files from the easymail7.zip file to the temp directory.
3. Run the easymail7_setup.exe file.
4. Follow the steps of the installation process.

Choose the EasyMail7 components that you want to install during the setup process. To start, install both the EasyMail7 Server and Client onto your personal computer or server.
5. Activation and First Run

If the program is successfully installed, the EasyMail7 Server automatically starts and runs as a service in the background.

Start G-Lock EasyMail7 Client component. On the login screen enter the IP address of the server where the EasyMail7 Server component is installed.

If you installed the EasyMail7 Server and Client on the same computer, enter your computer's name, or localhost, or 127.0.0.1 into the "EasyMail7 Server" field.

The port number is set automatically. The EasyMail7 Client uses the port 50888 to connect to the EasyMail7 Server.

For the first login to the EasyMail7 Server use the default login information (user name and password are case sensitive!):

User Name: Admin
Password: Admin

To learn more about G-Lock EasyMail7, visit http://easymail7.com
Click “Connect”.

Now you must get the key and activate the trial version of G-Lock EasyMail7.

Type your first name, last name and email address on the activation screen and click the “Get Free Key” button.

The message with your personal key will be sent at your email address so make sure you entered a valid email address.

Copy-paste your key on the activation screen.

Click “Activate”.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
After the activation, the program will ask you to change the default password to protect your G-Lock EasyMail7 data from unauthorized access.

Type your new password in the “Change admin password” screen. You can also change your username, enter your first name, last name and email address.
It’s highly recommended that you copy your new password and save it to a safe place. If you forget the password, there is no way to restore it, and you won’t be able to access the EasyMail7 Server.

Be sure to save your password to a place where you can easily find it.

Login again with your new password and username if you changed it, too.
6. Get Started: Settings Configuration

To get started, navigate to the “Get Started” section under the Settings menu and follow 3 quick steps:

Step 1. Add Email Account

Create an email server account where you will enter your sender information and SMTP settings.

Click on “Connect SES/SMTP” in the “Get Started” section.

Step 2

Import Contacts  Download Sample CSV

Step 3

Add Bounce Email Account

To comply with CAN-SPAM law, you must process bounce and unsubscribe emails after each sending.

Step 4 (optional)

Create an account on G-Lock Email Analytics to get full email tracking statistics (who unsubscribes, opens, clicks, forwards, prints, deletes your email, etc), and add unsubscribed contacts to the Global Exclusion List and unsubscribe them from local groups automatically.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
Enter your sender information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Name</td>
<td>Name for your account in G-Lock EasyMail7 (will not be shown anywhere in the message)</td>
</tr>
<tr>
<td>From Name</td>
<td>Will show up in the recipient's email as the person who sent the message</td>
</tr>
<tr>
<td>Email Address</td>
<td>Email address from which you will send emails. It must be a valid email address. When you enter the email address, it repeats throughout the form.</td>
</tr>
<tr>
<td>Reply E-mail Address</td>
<td>Email address that you want the replies to go to. If you do not enter a different email address into this field, the replies will be sent to the email address, from which you send them.</td>
</tr>
<tr>
<td>Bounce (Return) E-mail Address</td>
<td>Email address, to which you will receive bounce (returned) email messages. If you do not enter a different email address into this field, bounce messages will be returned to your &quot;From&quot; email address.</td>
</tr>
<tr>
<td>Organization</td>
<td>Specifies the name of your group, company or organization (not required)</td>
</tr>
</tbody>
</table>

Set the throttling options if necessary:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages per hour</td>
<td>Indicates how many messages the program can send per 1 hour from this account. The free version G-Lock EasyMail7 distributes 250 messages evenly for 1 hour.</td>
</tr>
<tr>
<td>Messages per day</td>
<td>Indicates how many messages the program can send per 1 day from this account.</td>
</tr>
<tr>
<td>Simultaneous SMTP connections</td>
<td>Indicates how many messages the program can send simultaneously from this account. The maximum number of simultaneous messages is specified by admin in the Workplace options.</td>
</tr>
</tbody>
</table>

To learn more about G-Lock EasyMail7, visit [http://easymail7.com](http://easymail7.com)
Then click on the Delivery Options tab.

G-Lock EasyMail7 supports several sending modes, but the most popular one is sending via SMTP server. G-Lock EasyMail7 can send emails through any 3rd party SMTP server. It can be your dedicated SMTP server or SMTP server of your Internet service provider (ISP).

In addition to that, you can use the SMTP settings of any 3rd party email sender such as SparkPost, SendGrid, Amazon SES and others.

To send emails through the SMTP server, select the “Send via SMTP Server” delivery option.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
Enter the SMTP server information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP Server</td>
<td>Enter the SMTP server name into this field. Some SMTP servers are predefined in G-Lock EasyMail7 so you can choose the SMTP server from the menu. If you use your ISP SMTP server, it usually reads something like mail.your-isp.com or smtp.your-isp.com.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port number. The default port is 25.</td>
</tr>
<tr>
<td>Security protocol</td>
<td>Select the security protocol if your SMTP server requires secure connection: Default (no SSL), STARTTLS or SSL.</td>
</tr>
<tr>
<td>My Server Requires Authentication</td>
<td>Check this option if your server requires authentication and enter your login and password.</td>
</tr>
<tr>
<td>Use POP3 Authentication</td>
<td>Check this option if your SMTP server requires a POP3 authentication and enter your POP3 server name, port number (usually 110), your login, and password. POP3 authentication means that you must connect to the POP3 server to be allowed to send the emails. As soon as you do it, the ISP opens you a &quot;window&quot; for some time during which you can send the messages.</td>
</tr>
</tbody>
</table>

To test the account, click on the "Test" button.

Enter a test email address and click OK.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
If the SMTP settings are correct, you will receive an email message saying that your SMTP settings are correct.

If the SMTP settings are not correct, the program will show you the error log. Scroll the log down and read the error. Fix it and test the SMTP settings again.

When the test passes, click OK to save the account settings.

Now go to the step 2 and import your email contacts.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
Step 2. Import Email Recipients

Click on “Import Contacts” in the Get Started section.

Select the option depending on the format of the file/database you want to import the recipients from.

If your email recipients are saved in a CSV file, you can download a sample CSV file to see how the fields are formatted.
Note: if you want to import email contacts from G-Lock EasyMail v6.xx, the EasyMail7 Client must be installed on the same computer where G-Lock EasyMail v6.xx is installed.

Select the file on the disk and click “Open”.

Enter a group name. By default, the program uses the file name as the group name.

Put the check marks for the fields that you want to import into the group and do the field mappings.

If the field names in your file match the field names in G-Lock EasyMail7, these fields will be mapped automatically.

If the field names in the file do not match the field names in G-Lock EasyMail7, map the fields manually by choosing the right field name from the drop-down menu in the "EasyMail Field" column.

The field containing the email address is required for mapping. Other fields are optional.
Important! If there is a field with the subscription status in your file, and you want to import it, map this field to the EasyMail7 “Subscribed” field and type the “subscribed” status in the “Format” field. For example, if the “subscribed” status is “Confirmed” in your file, type “Confirmed” in the “Format” field. The program will import subscribed users with the status 1 and unsubscribed users – with the status 0.

If you map the field with the subscription status to the EasyMail7 “Subscribed” field and leave the “Format” field empty, the program will import all users with the status 0 (unsubscribed).

To learn more about G-Lock EasyMail7, visit http://easymail7.com
If you do not have a field with the subscription status in the file or do not map this field during the group creation, the program will import all users with the status 1 (subscribed).

If you have a field with the subscription date/time in the file and want to import this field, map this field to the EasyMail7 “Subscribe_Date” field and select the correct date format in the “Format” field. The date format must match the date format in your file.

After the fields are mapped, click “Create”.

**Important!** If you have a Windows 64-bit system or installed the EasyMail7 Server on a clean machine without Microsoft Office, then you must download “Microsoft Access Database Engine 2010 Redistributable” (AccessDatabaseEngine.exe) for **32-bit Systems**

To learn more about G-Lock EasyMail7, visit [http://easymail7.com](http://easymail7.com)

Go to Start -> Run.

Type the local path to AccessDatabaseEngine.exe /passive

Example: D:\temp\AccessDatabaseEngine.exe /passive

Click OK.

After you imported the email contacts, go to the step 3 and add a bounce email account for processing bounce email messages.

**Step 3. Add Bounce Email Account**

To comply with the CAN-SPAM law, you must process bounce emails after each sending and delete or unsubscribe them in your list.

Go to the Get Started section and click “Add Bounce Email Account” button.

For your convenience, you can go to “Email Accounts”, select your account and click “Edit”.

Then click on “Add to Bounce Handler” button.
Enter your mail server address, password, and other required information in the Bounce Account settings.

Select the action what the program will do with bounce emails in the internal groups: delete from contact groups or unsubscribe in all groups.

Check the “Add unsubscribes to Global Exclusion List” option.

Click “Test” to check if your settings are correct.
Click OK to save the Bounce Account settings.

After you added an outgoing email server account, bounce email account and contacts, you can go to the next step and create an email message.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
7. Create Message

Return to the main program window and click “Message” under the Home menu.

Type the message text in the "Edit Message" window. Or, click on the Source tab at the bottom of the window and copy-paste the HTML source there.

You can also load an email message from file or web page. Click on the File menu and select the load or import option depending on where you want to load the message from.
You can fully customize the message using the HTML options and dynamic fields.

Under the Insert tab, you will find the insert options such as insert a table, attachment, symbol, picture, link, and line.

When the message is finished, you can click “Save” and save it to the Drafts folder.

If you don’t have your own email design, you can use any HTML template from the EasyMail7’s template store for inspiration.

Click on "Template Store" under the Home menu.

Choose the template and click on "Download template".

To learn more about G-Lock EasyMail7, visit [http://easymail7.com](http://easymail7.com)
When the template is installed, close the Template Store and click on “Templates” in the left pane.

Hover the mouse over the template name and click “Edit”.

The message editor will open where you can customize the message as you need by adding your company name, message text, dynamic fields, etc.

When you finished the customization, click “Save”.

8. Test Inbox Placement and Spam Score

Before you send the message to your real email contacts, it is highly recommended that you test your email deliverability with different mailbox providers to make sure that your email is delivered to the Inbox, not the spam folder.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
It also helps you monitor your sender reputation with different email service providers and make sure that you are in good standing with top domains on your list.

EasyMail7 is integrated with GlockApps email testing tools that provide a relevant reporting of email campaign performance with the Inbox/Spam testing, spam score and authentication testing.

To make the Inbox delivery and spam test, double-click on the message in the Drafts or Templates folder.

Choose the sending account in the “From” field.

Then click “Send” and choose "Send Spam Test" from the "Send" button menu.
Since Inbox Placement and span score tests are made through our GlockApps testing service, you’ll need to create an account with GlockApps the first time.

If you already have an account, simply login on the login form.

Then, select the providers you want to check your email with and click "Start."

G-Lock EasyMail7 will send your message to our seed list of email addresses with chosen service providers, and you will get the delivery report within a few minutes.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
To see the test delivery report, go to the Outbox and click on "View Report" on the test message.

The report presents:

- Inbox/Spam/Missing rate;
- sender authentication test (DKIM and SPF);
- sender IP reputation;
- spam filter tests;
- Inbox placement test;
- delivery duration.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
From the Inbox delivery testing report you can see how your message is treated by major Internet providers around the world and whether it is delivered to the Inbox, spam folder or blocked before reaching the recipient's mailbox. In Gmail, you will see if your message is delivered to the Primary or Promotions tab.

Spam filter testing helps you identify which filters are blocking your emails. You get a spam testing report from Postini and SpamAssassin. We also provide as much detail as we can squeeze out of them to help you troubleshoot.

Sender authentication testing checks your authentication each time you send an email to our seed list. You will be able to see on an individual email campaign basis whether your email is passing DKIM and SPF authentication.

Delivery duration tracking is also essential. It helps determine if there is an issue with ISP throttling. Rather than blocking your emails altogether, some ISPs will delay the delivery of emails when the volume passes a certain threshold. It can be particularly harmful to time sensitive promotions or important transaction emails.

9. Send Test Message

In addition to the Inbox Placement and spam score test, you can quickly send a test message to yourself to check if it looks well in the email client when received.

Or, you can create a group with your test email addresses and always use that group for sending a test message before each campaign.

To send a test email message, select “Send Test” from the "Send" button menu.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
On the "Send Test Email" window select the option "To email:" or "Group:"

The "To email:" option allows you to send a test message quickly to one or several email addresses without adding them to the group.

Commas or semicolons must separate email addresses.

**Important!** When you send a test email using the "To email" field, dynamic fields except the unsubscribe link and social links do not work.
If you have a group of test email addresses, select the "Group:" option and then select your test group from the menu.

You can add email addresses to which you do not want to send the test email to the Exclusion list by using the > button.

Click "Send".
Check mail on your test email addresses to see how the message displays. If any corrections are needed, you can make them now and re-send a test message.

10. Send Message to the Contact Group

After testing your Inbox delivery and making sure that your email is delivered to the Inbox with your top domains, you can send an email campaign to your contact group.

Select the group in the “Group” field.

Click “Send”.

Select “Send Now” from the “Send” button menu.
Note: if you have duplicate email addresses between groups and send the message to more than one group at a time, the program does not send the message to all duplicate addresses. The message is sent only to the first email address that occurs.

When you send the message to a database and have duplicate addresses in the database, the message is sent to the first email address out of duplicate emails that occur in the database.

You can watch the sending process in the Outbox. This is where sent emails are stored.

After the sending is complete, you can click on “View Log” and look at the general sending log of the message.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
Also, you can click on “Processed”, “Sent” and “Failed” to look at processed emails (sent + failed), sent and failed (not sent) emails.

11. Work with EasyMail7 Web Client

G-Lock EasyMail7 has built in Web Service and offers a RESTful interface for consuming JSON content via AJAX or mobile clients.

We included the basic demo web client into the program installation that shows how to create a RESTful JavaScript client.

In the current version of the web client you can:

- compose an email message from a template or draft;
- compose an email message from scratch;
- send an email message to one or several groups;
- save an email message as a draft;
- edit and delete templates and drafts;
- view contacts in internal and external groups (databases);
- view sent emails in the Outbox.

The current version of G-Lock EasyMail7 web client does not allow you to create email server accounts, add contact groups, create links to databases, or handle bounce and unsubscribe emails.

You can login into the web client in any browser on any device including iPad, Android Tablet PC, Windows tablet PC etc. and run an email campaign, check how the email campaign was sent, look through the contacts or simply check the data you have on the EasyMail7 Server.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
Install G-Lock EasyMail7 Web Client

You can optionally install G-Lock EasyMail7 web client when you are installing G-Lock EasyMail7.

To install G-Lock EasyMail7 web client:
1. Check the "Install Web Client" option during the setup process.
2. Click “Next”.
3. Finish the setup process.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
**Login into Web Client**

After you installed G-Lock EasyMail7 web client, you can login into it in your browser.

To login into G-Lock EasyMail7 web client:

1. Open the URL `http://[EasyMail7 Server IP]:50888/wps/www` in the browser

   Replace `[EasyMail7 Server IP]` in the URL with the IP address, or computer name, or domain name where the EasyMail7 Server is installed. Example: `http://127.0.0.1:50888/wps/www`

2. Log in with your username and password.

3. Click "Sign in".

4. After you log in, select the workplace you will work within.

To learn more about G-Lock EasyMail7, visit [http://easymail7.com](http://easymail7.com)
Compose and Send Message

In G-Lock EasyMail7 web client, you can compose an email message from scratch or an existing template, but you cannot import the message from a file or web page.

To compose and send a message:

1. Click on the "Compose" button to create a new email from scratch.

Or, click on "Templates" at the left side, select a template and click on "Create New Message".
2. Use the options of the HTML editor to compose the message. Or, you can click on "Source" and copy-paste your HTML source.

**Important!** In the web client, you cannot use the Merge menu. To merge the contact's data, unsubscribe link or social links into the message, type the correct merge tags manually.

3. Select the email server account in the From menu.

4. Select the group(s) in the To field. If you select more than one group, the program shows just the number of groups, for example, 2 groups, instead of the groups names.

5. Click "Send Now".

To learn more about G-Lock EasyMail7, visit [http://easymail7.com](http://easymail7.com)
You can watch the sending process in the Outbox.

Click on "View Log" to see the general sending log.

Click on "Processed", "Sent" and "Failed" to see processed, sent and failed emails.

Click the "Start Sending" button to resend failed emails.

To learn more about G-Lock EasyMail7, visit http://easymail7.com
Edit and Delete Templates

In G-Lock EasyMail7 web client, you can edit and delete existing templates but you cannot import new templates from files or template store, or create templates categories.

**To edit a template:**

1. Click on "Templates" at the left side.
2. Click on the template category under "Templates" if you want to edit a template from the category.
3. Click on "Edit Template" under the template name.
4. Make the changes to the template and click "Save".

**To delete a template:**

1. Click "Delete" below the template name.
**Edit and Delete Drafts**

In G-Lock EasyMail7 web client, you can create a message and save it as a draft.

**To edit a draft:**

1. Click on "Drafts" at the left side.
2. Click on "Edit Message" under the draft name.
3. Make the changes to the draft and click "Save".
Or, click "Send Now" to send the message immediately.

**To delete a draft:**

1. Click "Delete" under the draft name.

**View Contacts in Groups and Databases**

In G-Lock EasyMail7 web client, you can only view the contacts in internal groups and databases. You cannot create new groups or links to databases.

Neither can you edit, delete, add new contacts to the group or manage the exclusion list.

**To view contacts:**

1. Switch to the "Contacts" tab.
To learn more about G-Lock EasyMail7, visit [http://easymail7.com](http://easymail7.com)

2. Click on the group name or database link name.

<table>
<thead>
<tr>
<th>My Databases</th>
<th>Contacts</th>
<th>My Subscribers</th>
<th>My Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>contacts</td>
<td>Maillist</td>
<td>Subscribers</td>
<td>test</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contacts 2</td>
<td>My_Contacts</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>My_Subscribers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Unconfirmed_Subscribers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Customers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Buyers List</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>My Subscribers</th>
<th>Contacts</th>
<th>My Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Contacts</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exclusion list</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:seocombat@gmail.com">seocombat@gmail.com</a></td>
</tr>
<tr>
<td><a href="mailto:got.ofl@live.com">got.ofl@live.com</a></td>
</tr>
<tr>
<td><a href="mailto:info@glocksoft.com">info@glocksoft.com</a></td>
</tr>
<tr>
<td><a href="mailto:ghichgo@support.com">ghichgo@support.com</a></td>
</tr>
<tr>
<td>ftfygyt.com</td>
</tr>
<tr>
<td><a href="mailto:hgdryl@hhtc.au">hgdryl@hhtc.au</a></td>
</tr>
</tbody>
</table>

Favorite calls
- 03/31/2014 @ 2:16 PM
- 03/03/2014 @ 4:14 PM

[G-Lock EasyMail7 Beta]
Tester Invitation
- 03/03/2014 @ 4:14 PM

Templates
Drafts
Trash
Outbox
12. Useful Articles

Before you start composing and sending an email message, please, read these articles on our website:


From these articles, you will learn how to re-size, crop and compress images directly in G-Lock EasyMail7 before inserting them into the message and how to upload images to your web server in order to decrease the message size, speed up sending and save your money if you are paying for traffic with your email provider like Amazon SES.

13. Support & Contact

G-Lock EasyMail7 has a support page at [http://easymail7.com/contact-support/](http://easymail7.com/contact-support/) where you can ask for a solution to your problem using the contact form. We usually reply within 24 hours on business days.

Also, you can contact us via email at support@glocksoft.com or via a live online chat on our main website [http://www.glocksoft.com](http://www.glocksoft.com). The chat is available on business days during our working hours 10:00 – 18:00 +3GMT.

Copyright © G-Lock Software. All Rights Reserved.